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Legal Disclaimer
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[bookmark: _Toc114231381][bookmark: _Toc516648434][bookmark: _Toc11147450]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition

[bookmark: _Toc114231382]File Transfer Updates
[bookmark: _Toc93580783][bookmark: _Toc114231383]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	June 10, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc93580784][bookmark: _Toc114231384]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
IMPORTANT!

Upcoming PGP key changes:

• The legacy (non-rotating) key, key ID D4D727C0, will be deprecated on October 11, 2022.

• The current rotating key, key ID 40AC5D35, will expire on September 4, 2022. 

• A new rotating key, key ID 9AFF10B5, is available in the client's root folder.
New rotating PGP key details:
· Key ID: 9AFF10B5
· Filename: concursolutionsrotate.asc
The filename for the rotating PGP key does not change when the key is rotated.
· As of June 4, 2022, the new rotating public PGP key is available in the client’s root folder. 
· RSA 4096-bit signing and encryption subkey.
· This key expires on September 4, 2024.
· Clients are responsible for replacing the rotating key before it expires.
· A new key will be provided 90 days before the September 4, 2024 expiration date.
Expiring rotating PGP key details:
· Key ID: 40AC5D35
· Filename: concursolutionsrotate.asc
· This key will expire on September 4, 2022.
Legacy (non-rotating) PGP key details:
· Key ID: D4D727C0
· The SAP Concur legacy (non-rotating) PGP key will be deprecated on October 11, 2022. 
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
· AWS transfer endpoints (when they are communicated to you)
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
Admin Experience
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the new rotating key to their PGP keyring and start using it to encrypt files being transferred to SAP Concur any time prior to September 4, 2022. 
If you require assistance, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc114231385]Help Menu
[bookmark: _Toc114231386][bookmark: _Hlk96071113]**Ongoing** Consolidation of Resources Under Help Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	September 16, 2022
	July 6 and late September 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231387]All Products | All Editions
Overview
On July 6, SAP began consolidating SAP Concur help resources under the Help menu in SAP Concur solutions. The changes will occur in two phases:
· Phase 1 -July 6, 2022: The Help menu was updated. Updates include changes to the overall appearance and organization of the menu. In addition, for clients with SAP Enable Now content, users can access SAP Enable Now content from the Help menu.
For more information about support for SAP Enable Now, refer to the Support for SAP Enable Now release note in this document.
· Phase 2 – Targeted for late September 2022: 
User assistance for admins and end users (OEM WalkMe), video tutorials, and tools for contacting support will be accessed from the consolidated Help menu.
The Get Assistance icon (?) that is currently used to access those items will be removed from the UI.
On SAP Concur Standard edition, if user assistance is enabled and a client is in the implementation phase or trying the free trial version, a new chat icon will be available.
For more information about user assistance for admins and end users, refer to the User Assistance for Admins and End Users fact sheet.
Business Purpose / Client Benefit
These changes improve ease of use and simplify the SAP Concur user interface by providing a single point of access to help resources.
End-User Experience
As of July 6, 2022, when an admin or end user clicks Help, they see the redesigned Help menu, and, if SAP Enable Now content is available to them, they will see the Explore Interactive Content item in the menu.
Previous Menu Example
[image: ]
Current Menu Example
[image: ]
The list of items in the Help menu depends on a user's roles and permissions and on the configuration of the client's site. For example, only users with administrator privileges have access to Administrative Resources.
When all of the changes have been implemented, new options will be available in the Help menu—for example, if User Assistance for End Users is enabled, a link to access those resources will appear in the Help menu. In addition, the Get Assistance icons that currently provide access to those features will be removed from the user interface.
Current Get Assistance Icons
[image: ] [image: ]
In addition, on SAP Concur Standard edition entities that are in the implementation phase or are a free trial instance, a chat icon will be available on pages in the UI.
Future Chat Icon
[image: ] [image: ]
Configuration / Feature Activation
These changes will be implemented automatically.
[bookmark: _Toc114231388]Home Page
[bookmark: _Toc114231389]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 4, 2020
	May 13, 2022
	Q4 2021 – Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231390]All Products | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: In October of 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: At a date to be determined, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
End-User Experience
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc114231391]Miscellaneous
[bookmark: _Toc114231392]**Ongoing** New IP Address Range for Callouts (EMEA, US)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 12, 2022
	--
	August – December 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231393]Expense, Request | Professional & Standard
Overview
Beginning in August and continuing through the end of 2022, servers that support SAP Concur callouts in the US & EMEA datacenters will be upgraded. This maintenance includes migration of some services to new servers. This means that clients should anticipate that, when the migration occurs, the IP addresses associated with these services will change.
These servers support the following functionality:

· Fetch Attendee Data Callout
· Fetch List Item Callout
· Event Notification Callout
· Launch External URL Callout
· Concur Salesforce Connector
IMPORTANT: We do not anticipate any interruption in functionality for clients who use SAP Concur callout; however, clients who use allow lists or otherwise restrict SAP Concur IP addresses might need to update their lists to avoid disruption of some functionality. SAP recommends adding *concursolutions.com to your allow lists rather than specific IP addresses.

Business Purpose / Client Benefit
This migration improves the stability and reliability of connections that pass these servers.
Configuration / Feature Activation
We do not anticipate any interruption in functionality for clients who use SAP Concur callout; however, clients who use allow lists or otherwise restrict SAP Concur IP addresses may need to add the new IP addresses to their lists to avoid disruption of some functionality.
SAP recommends adding *concursolutions.com to your allow lists rather than specific IP addresses. If your company requires specific IP addresses, contact SAP Concur support or your SAP Concur representative for assistance.
[bookmark: _Toc114231394]**Ongoing** SAP Concur Migration to Cloud Platform in AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	September 16, 2022
	Ongoing in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231395]All Products | All Editions
Overview
SAP Concur plans to migrate from a pure private cloud operation, where all equipment is owned by SAP Concur, to a cloud platform. We plan to close our own private data centers in favor of a cloud platform implemented in Amazon Web Services (AWS). While this process started in 2017, we are focused on the final phase of the migration in 2022 for the North American and EMEA data centers.
Business Purpose / Client Benefit
This change provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
End-User Experience During Migration
While a company is being migrated from an SAP Concur private data center to the cloud platform, their SAP Concur solutions might not be available to end users. 
If an end user tries to sign in to SAP Concur solutions during the migration process, they might not be able to sign in and they might receive the following message:
"SAP Concur solutions is undergoing scheduled maintenance. Please try again later"
[image: ]
If an end user is working in SAP Concur solutions when their company is migrated, they might be returned to the sign in page.
SAP plans to implement migrations on weekends and after business hours. 
Admin Experience – Preparing for Migration
Review Network and API Connections
· For clients who use allow lists to manage connections to their SAP Concur solutions including API connections, SAP recommends you add *.concursolutions.com to your allow list.
IMPORTANT: If you allow specific URLs or IP addresses, review the Updated Naming Convention for Sub-URLs and Updated IP Addresses sections that follow.
· Always store the geolocation and the refresh token as they may have changed. On subsequent calls, use the last received geolocation and refresh token.
For detailed information, refer to the documentation on the SAP Concur Developer Center:
Base URIs
Updated Naming Convention for Sub-URLs
In June 2021, SAP Concur implemented a more consistent naming convention for the URLs used to connect to SAP Concur solutions, based on data center. Users who navigate to www.concursolutions.com will be automatically routed to the correct URL or single sign-on (SSO) as part of their sign-in process. 
In rare cases, clients who restrict or filter access from their corporate network to specific URLs might need to update their configuration to enable users to connect to the new URLs. 

In rare cases, direct URLs pointing to web pages on concursolutions.com might need to be updated—for example, if you use direct URLs in your training materials. 
The URLs that were implemented in June 2021 are as follows: 
· us.concursolutions.com
This URL is functionality identical to the existing www.concursolutions.com. 
· eu.concursolutions.com
This URL is functionally identical to the existing eu1.concursolutions.com 
· us2.concursolutions.com and eu2.concursolutions.com
These are the URLs for data centers in AWS
It is not a best practice to only allow specific URLs. If restricted access is a requirement, SAP recommends allowing *.concursolutions.com to avoid having to make these adjustments in the future. 
For more information, view the June 2021 Release Notes for your product: Standard | Professional.
Updated IP Addresses
Similar to the new sub-URLs, each new data center will have a new set of IP addresses. We do not anticipate any interruption in functionality; however, clients who use allow lists or otherwise restrict SAP Concur IP addresses might need to update their lists to avoid disruption. 
In addition, when the migration occurs, the IP addresses associated with SAP Concur services will change (for example, Callout connectors, the Salesforce connector, or an internal firewall). 
SAP Concur does not recommend allow listing IP addresses. The recommendation and best practice is to add *.concursolutions.com to your allow lists rather than specific IP addresses. 
If your company requires specific IP addresses, contact SAP Concur support or your SAP Concur representative for assistance. 
Configuration / Feature Activation
This change will occur automatically.
For details, refer to the SAP Concur Cloud Platform Strategy FAQ.
[bookmark: _Toc114231396]Profile Settings
[bookmark: _Toc114231397]**Ongoing** Changes to My Profile, Home Page, and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	September 16, 2022
	Ongoing beginning in April 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231398]Travel, Expense, Invoice, Request, Mobile | Professional & Standard
Overview
SAP has implemented or plans to implement changes to several pages in the SAP Concur UI. The changes will be implemented over time beginning in April of 2022 and continuing in 2022 and 2023. 
These changes reflect SAP's commitment to supporting gender diversity by enabling gender non-binary users to enter consistent information when making travel arrangements and entering information in SAP Concur solutions. 
For complete details including release dates for implemented changes and information about planned future changes, refer to the refer to the Preferred Name and Nonbinary Gender Options fact sheet.
[bookmark: _Toc114231399]Security
[bookmark: _Toc114231400]Some TLSv1.2 Ciphers No Longer Supported 

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	July 8, 2022
	February 1, 2022 & Nov/Dec 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231401]Travel, Expense, Invoice, Request | All Editions
Overview
SAP Concur no longer supports connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	[bookmark: _Hlk106881988]Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher.
Because some SAP Concur clients use an operating system that does not yet support any of the SAP Concur supported ciphers, removal of support for the following cipher has been postponed:
	Akamai/OpenSSL cipher name
	IANA cipher name

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384


Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
1. Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc114231402]Test Entities | Production Sandbox Environment
[bookmark: _Toc114231403]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	September 9, 2022
	October 1, 2021 - Q4 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231404]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
End-User Experience
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc114231405]**Ongoing** Production Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	September 9, 2022
	October 1, 2021 - Q4 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231406]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for clients regarding this update, we want to ensure clients are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New clients will use the AWS production URL–https://us2.concursolutions.com or https://eu2.concursolutions.com–with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat, as shown). 
[image: Screenshot of Sign In area of Concur Expense with login ID featuring the appended .uat domain. For example: johnsmith@123.com.uat] 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc114231407]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	September 9, 2022
	October 1, 2021 - Q4 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231408]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Admin Experience
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc114231409]User Administration
[bookmark: _Toc114231410]**Ongoing** Standalone White Spaces No Longer Valid in First and Last Name Fields

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 17, 2022
	August 5, 2022
	July 26, 2022 – Future releases

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231411]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to apply validation that prevents the use of standalone white space characters in first and last name fields. This validation will be implemented in phases, beginning on July 26, 2022.
Changes implemented on July 26, 2022:
· If a name field is populated with only white space characters via the profile v4 API, an error message is returned and the entries are not accepted.
Changes planned for a future release:
· Standalone white space characters will no longer be accepted as a valid entry in name fields in user accounts.
White space characters that are part of a valid name will be accepted.
· Standalone white space characters will no longer be accepted as a valid entry in name fields on the My Profile – Personal Information page.
White space characters that are part of a valid name will be accepted.
· If a name field is populated with only white space characters via the employee import file or through manual entry, a message or error will be returned and the entries will not be accepted. 
The type of response received when entering an invalid name depends on the method of entry.
Business Purpose / Client Benefit
Ensuring that valid names are entered into the name fields in SAP Concur solutions can prevent errors when the data is exported to external systems that do not support or cannot process standalone white space characters in name fields.
Admin Experience
If an admin attempts to enter only white spaces in a name field on the User Details page, through an API call, through the employee import process, or through manual entry, the entry or entries will not be accepted and a message or error will be returned. On the user accounts page, the user account will not be saved.
White space characters that are part of a valid name—for example, "Mary Ann"—are valid and will continue to be accepted. 
Configuration / Feature Activation
This validation will be added automatically.
[bookmark: _Toc114231412]User Assistance for Admins and End Users
[bookmark: _Toc114231413]New Tours Added to User Assistance for Admins and End Users (US, EMEA)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 16, 2022
	--
	September 19, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231414]Expense, Request | Professional & Standard
Overview
The SAP Concur September release includes new User Assistance content (tours). The new tours expand the scope of information provided by User Assistance for Admins and End Users.
The following new tours are included in the September release:
· Concur Expense
Recall an Expense Report
· Concur Request Integrated with Concur Expense
Recall a Request
[bookmark: _Hlk114136779]Business Purpose / Client Benefit
User Assistance for Admins and End Users assists admins and users to learn new tasks more quickly and efficiently by providing guided tours with step-by-step instructions for completing a task. Enabling users to learn and complete tasks more easily drives user adoption, increases efficiency, improves user experience, and improves user satisfaction with SAP Concur solutions.
Configuration / Feature Activation
The new tours are automatically available on entities where User Assistance for Admins and End Users is enabled.
For more information about User Assistance for Admins and End Users, including steps for enabling and configuring User Assistance for Admins and End Users, refer to the User Assistance for Admins and End Users fact sheet.
[bookmark: _Toc114231415]User Export and Import
[bookmark: _Toc114231416]User Export and Import Improvements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	April 22, 2022
	September 16, 2022
	July 21, 2022 – Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231417]Expense, Invoice, Request | Standard Edition
Overview
SAP Concur has implemented improvements to the user export and import processes.
Improvements include, but are not limited to:
· Improvements to the downloadable user data template including tooltips and drop-down lists
· Removal of the 1000 user maximum for imports and exports of user data
· The addition of a new Manage Users via a Spreadsheet page
These improvements were implemented on July 21, 2022 as part of an opt-in experience including a survey for providing feedback on the new experience. 
As of August 25, the new experience became the default experience. User admins can still choose to switch back to the old experience and can provide feedback via the survey.
In a future release, the ability to switch back to the old experience and the survey will be removed from the Users page.
Business Purpose / Client Benefit
These improvements increase the ease of use and experience of the user import and export processes.
Admin Experience
On the Users page in Product Settings, a banner with the following message is available at the top of the page:
"Click here to try out the new Manage User via a Spreadsheet experience, and provide your early feedback."
[image: ]
The admin can click the word "here" to opt-in to the experience.
[image: ]
After they click here, the banner message text changes to the following:
"Welcome to the new Manage User via a Spreadsheet experience. In addition to the new UI, we have also updated the spreadsheet template to include user-friendly header rows, drop-down menus, and tooltips for your reference. Click here to provide your feedback on the new experience. If you like, you can change back to the existing experience."
[image: ]
In the new message, the admin can click the word "here" to provide feedback on the experience through a brief survey.
The admin can also click the phrase "change back to the existing experience" to opt out of the new spreadsheet experience.
After opting in to the experience, on the Users page in Product Settings, when the admin clicks Add Users > From Spreadsheet, the admin sees the new Manage Users via a Spreadsheet page.
[image: ]
On the Manage Users via a Spreadsheet page, the admin can export, update, and import user data.
[image: ]
When they export the spreadsheet, they will see new tooltips and, where applicable, drop-down lists in the spreadsheet. In addition, they will no longer be limited to downloading 1000 rows of user data.
Tooltip Example
Tooltips appear when you hover over a column header in the spreadsheet.
[image: ]
Drop-down List Example
Drop-down lists are available for columns where applicable.
[image: ]
Configuration / Feature Activation
After the opt-in period has ended, the new user export/import experience will be automatically available.
[bookmark: _Toc114231418]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc114231419][bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899]Exchange Rates
[bookmark: _Toc114231420]**Planned Changes** Automatic Provisioning of Central Bank Exchange Rates for Selected Countries

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 5, 2022
	September 9, 2022
	December 12, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231421]Expense, Invoice, Request | Professional & Standard
Overview
On December 12, 2022, SAP Concur plans to provide foreign exchange rates from the central bank for the following countries:
· Czechia
· Poland
· The Russian Federation
· Türkiye (Turkey)
Business Purpose / Client Benefit
This change helps SAP Concur achieve regulatory compliance with local country rules for exchange rates.
Admin Experience
For clients who are using SAP Concur-provided exchange rates, the exchange rates for users who are reimbursed in the official currency of the specified countries will automatically employ central bank rates. 
Configuration / Feature Activation
This change occurs automatically. For clients who are using SAP Concur-provided exchange rates, no configuration is required.
For clients who import custom exchange rates for these countries, additional information will be provided about how to transition to the SAP Concur-provided rates.
[bookmark: _Toc114231422]Fax Feature
[bookmark: _Toc114231423]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231424]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022, the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
End-User Experience
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. Additional information about this change will be made available over the coming months.
[bookmark: _Toc114231425][bookmark: _Toc79737887]File Transfer Updates
[bookmark: _Toc114231426]**Planned Changes** New File Transfer Endpoints After Migration to AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 10, 2022
	June 17, 2022
	Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231427]All Products | Professional & Standard
Overview
With the SAP Concur migration to Cloud Platform in AWS, new endpoints will be implemented for file transfers. After your entity is migrated to the new platform, you will receive notification about the migration including the new endpoints. After you receive notification, you will have 30 days to switch from the old endpoint(s) to the new AWS Transfer endpoint(s).
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
Business Purpose / Client Benefit
The SAP Concur migration to Cloud Platform in AWS provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Configuration / Feature Activation
After you receive notification that your entity has been migrated to AWS, you will have 30 days to update your systems to point to the new AWS Transfer endpoints.
IMPORTANT! Do not switch endpoints until you have been notified. Doing so will have unpredictable results.
[bookmark: _Toc114231428]Imaging
[bookmark: _Toc114231429]**Planned Changes** Imaging Database System Maintenance

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 5, 2022
	September 16, 2022
	October - December

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231430]Expense, Invoice, Request, Travel, Budget, Mobile | Professional & Standard
Overview
SAP Concur plans to perform system maintenance on the Concur Expense and Concur Invoice imaging databases. The system maintenance will be performed in phases, beginning in October 2022, and ending in December 2022.
What clients can expect:
· To avoid working hours, maintenance operations will take place on Saturday in the region where the maintenance is taking place.
· With a few exceptions noted as follows, maintenance operations impact all clients.
PSCC clients and clients in the China datacenter are not impacted by this image database migration.
· The maintenance tasks can take 2 to 4 hours.
Business Purpose / Client Benefit
This maintenance operation increases the stability of the imaging feature and better supports document compliance for tax authorities.
End-User Experience
[bookmark: _Hlk84497369]While the system maintenance is in progress, users will not be able to attach, view, or modify images in Concur Expense, Concur Invoice, or Concur Request, nor through web services or mobile applications.
 The Concur Invoice product will be unusable during the maintenance period since viewing invoice images is a core feature of the product.
Users might also receive one of the following messages:
· Invoice Image:
Concur Imaging Service Not Available
· E-Receipt:
Retrieving Images from Image Server. Please wait…
· Mobile:
We’re unable to attach your receipt. Please try again.
· Attach to Report:
Alert! The following files failed to upload: <filename>
Or
No file chosen
Configuration / Feature Activation
Clients do not need to take any action to facilitate the system maintenance.
[bookmark: _Toc114231431]User Assistance
[bookmark: _Toc114231432]**Planned Changes** Concur User Assistance by WalkMe to be Enabled

	Information First Published
	Information Last Modified
	Feature Target Release Date

	July 15, 2022
	September 16, 2022
	October 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc114231433]All Products | All Editions
Overview
In October, 2022, SAP Concur plans to enable Concur User Assistance by WalkMe on client sites with Concur Expense and/or Concur Invoice. User Assistance by WalkMe helps administrators and end users complete tasks by providing guided help while they are using SAP Concur solutions.
This change does not impact the following clients:
- Clients with Concur Travel only
- Clients with SAP Enable Now for Concur
Business Purpose / Client Benefit
This feature helps users learn new tasks more quickly and efficiently, driving user adoption, increasing efficiency, improving the user experience, and improving user satisfaction with SAP Concur solutions.
Admin Experience
User Assistance Settings Page
After User Assistance by WalkMe is enabled, the administrator will be able to access the User Assistance Settings Page to enable and disable User Assistance by WalkMe for their end users.
Professional Edition
After the feature is enabled by SAP Concur internal staff, a client admin with the Company Administrator role can access the User Assistance Settings page from the Company Administration page.
[image: ]
For more information about roles, refer to the Shared: User Administration Guide.
Standard Edition
After the feature is enabled by SAP Concur internal staff, a client admin with the Can Administer permission can access the User Assistance Settings page from the Administration > Company > Tools page. 
[image: ]
For more information about Concur Standard Edition permissions, refer to the Shared: Users Setup Guide for Concur Standard Edition.
Enabling/Disabling User Assistance for End Users
On the User Assistance Settings page, the administrator can enable and disable user assistance for end users globally. They can also enable and disable user assistance for end users based on a user’s assigned country or region. 
When the administrator selects a country/region on the User Assistance Settings page, the feature is enabled for all end users assigned to that country/region. 
[image: ]
Enabling or disabling user assistance for end users does not impact user assistance for admins. User assistance for admins is enabled and disabled by SAP Concur internal staff. 
End-User Experience
After the feature is enabled, User Assistance by WalkMe content can be accessed through the SAP Concur Help menu by clicking Explore Interactive Help. 
[image: ]
The list of items in the Help menu depends on a user's roles and permissions and on the configuration of the client's site. For example, only users with administrator privileges have access to Administrative Resources.
When the user clicks Explore Interactive Walkthroughs, the Get Assistance panel opens. The Get Assistance panel provides access to a list of resources including guided tours, video tutorials, and documents such as user guides.
[image: ]
The guided tours that are available in the Get Assistance panel are relevant to the page the user is on. For example, when the user is on the Manage Expenses page, the guided tours in the Get Assistance panel reflect tasks that can be performed on that page, such as creating an expense report and viewing expense details.
[image: ]
If a user clicks on a guided tour, they are guided through the selected task by a series of messages.
Example Guided Tour: Create an Expense Report 
[image: ]
[image: ]
[image: ]
Configuration / Feature Activation
SAP plans to enable User Assistance by WalkMe in October, 2022. After the feature is enabled, clients who do not wish to have User Assistance by WalkMe enabled can open an SAP Concur support ticket to disable the feature.
This change does not impact the following clients:
- Clients with Concur Travel only
- Clients with SAP Enable Now for Concur
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc114231434][bookmark: _Toc11147478]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc114231435][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc114231436]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc114231437]Subprocessors
[bookmark: _Toc480899346][bookmark: _Toc483562025][bookmark: _Toc484092110][bookmark: _Toc510082431][bookmark: _Toc514338228][bookmark: _Toc69118207][bookmark: _Toc114231438]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors / Data Transfer Factsheets page.

To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
Sign in to the SAP Support Portal using your Support User ID (S-user) and password.
SAP customers must sign in to the SAP Support Portal using their Support User ID (S-user) and password. For information about S-User IDs, refer to Your New Support User ID (S-user). 
On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in the Search field.
In the Title column, click SAP Concur Sub-processors List.
If you have questions or comments, please reach out to: Privacy-Request@Concur.com 

[bookmark: _Toc77840903][bookmark: _Toc114231439]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc114231440]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc114231441]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc114231442]Online Help
You can access release notes, setup guides, user guides, admin summaries, supported configurations, and other resources via the in-product Help menu or on the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com).
[bookmark: _Toc114231443][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the required permissions, Contact Support is available on the SAP Concur Help menu and in the SAP Concur page footer. 
[image: ]
Click Contact Support to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
© 2022 SAP SE or an SAP affiliate company. All rights reserved.
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